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OUR NEXT MEETING: 

Thursday, August 8, 2013 
7pm at Key Largo Library 

Community Room  
MM 101.4 Oceanside

“Learn iPhoto the 
Easy Way”

Tutorials can be your best friend, 
and they are free and plentiful 

online.  

Speaker Karen Beal will show 
you where to find them and how 

to use them.

 

by Karen Beal

Beginners: Come at 6:30 and bring your 
Mac and your questions. There

will be some experienced users there to 
help for the half-hour before the

formal presentation starts! Experienced 
users: please come and help!

continued on page two

JACKIE HARDER has newspaper ink in her 
blood! After 30 years in the newspaper business 
(most recently as editor of  The Reporter), Jackie 
transitioned into a job as President/C.E.O. of  
the Key Largo Chamber of  Commerce. After 
seven years at that, and at almost 60 years old, 
she realized that if  she was ever going to work 
for herself, “now is the time”... and she took 
the leap. She says she is “building her wings on 
the way down.” She’s gotten her credentials in 
order and now she is a business and life coach. 
She also builds websites, and provides content 
for blogs and social media sites, utilizing her 
vast experience in writing and public relations. 

Jackie Harder 
Shares Eight Things 
You Should Know 
About Social Media 
Networking

by Sue Beal

July’s meeting was a departure from our 
usual tech-oriented presentations. Jackie 
Harder was an engaging and energetic 
speaker, and the topic of  social media was 
fascinating. We’ve all seen Facebook, or 
Pinterest, or Twitter... many of  us use them 
every day... but Jackie gave us insights we 
might not have come to on our own.

We challenged Jackie, too. She had 
never prepared a Power Point (or Keynote) 
presentation before!! Her slideshow was 
stellar. She carefully chose cartoons and 
graphics to illustrate her points perfectly, 
and she shared them with us so I was able 
to include some of  them here. I think you’ll 
enjoy them.

The top social media sites are ranked 
as follows:

Facebook – 1 billion users
Tencent QQ (China) – 784 million
Skype – 663 million
Google+ – 500 million plus
Twitter – 500 million plus
LinkedIn – 250 million 

Yeah, I know. I’ve never heard of  Tencent 
QQ either, but then, we are not Chinese!! 
While just about anyone uses one or 
more of  these (half  the room that night 
were Facebook users), LinkedIn is just for 
professional networking. Very popular for 
business. (Jackie was honored to be among 
the top 1% most endorsed public relations 
professionals in the U.S. on LinkedIn!)

Pinterest didn’t make the ranking but it’s a 
fast-growing site, popular with middle aged 
women. People post (“pin”) pictures and 
bits of  info of  interest on a sort of  bulletin 
board to share on different topics.

About UKMUG

UKMUG meets  at the Key Largo 
Library Community Room on the 
second Thursday of  each month. 
Speakers begin at 7pm. and may go 
as late as 9pm.

Are you a beginner needing Mac 
help? Come at 6:30 and bring your 
Mac and your questions. There will be 
some experienced users there to help 
for the half-hour before the formal 
presentation starts.

Voluntary annual dues are collected 
in Jan-Feb-Mar: $25.

Bringing a little humor into your self  image is 
helpful! Jackie started with this cartoon.
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Social Media Networking
continued from page one

continued on page three

Brittney and Diann - newcomers to UKMUG.

Diane & Vale share stories at the break.

ACT NOW
to sign up for

Digital Photography 
Beyond the Camera
with Pete Bacheler at FKCC

Learn to shoot beautiful photographs 
with your digital camera. This 

course will take students beyond 
the technical aspects of their 

digital camera to cover improving 
composition and shooting styles. 
Topics covered will include a brief 

overview of digital camera functions, 
photojournalistic, traditional and 

artistic photography, as well as on 
location tips and techniques.

This class will take your photography 
to an exciting new level!

Students must bring their own 35mm 
format digital camera to class.

Upper Keys 
September 3 to October 29, 2013

Tuesdays / 6-8 PM  $155

Marathon Key
September 4 to October 30, 2013

Wednesday / 6-8 PM  $155

Call the registrar 305-809-3185 or  
305-809-3250 (Office)   

Instagram is another site that’s growing 
in popularity. Jackie said there are about 
300 recognized social media sites, and all 
sorts of  niche sites are popping up. Are you 
Mongolian? There’s one for you!

One to two million people visit these sites 
every day. 93% of  people under age 32 use 
social media sites as their search engines. 
That’s right. Instead of  going to Google, 
they go to their favorite social media site and 
search!! (Who knew?!) The search returns 
results outside the social media realm, but 
it’s weighted in favor of  the social media 
sites (i.e., they come up first).

Many young people have left Facebook, 
as it now has too many older folks on it 
for their taste.
1. It’s SOCIAL

It’s all about being social; interacting with 
other people. Jackie gave us an example of  
how it works for her.

Her coach challenged her to write an 
inspirational story about herself. She wrote 
about how she started out from college, 
interviewing for her first job, and said she 
could “do just about anything better than 
just about anybody.” (If  you know Jackie, 
you are smiling — you know she has never 
lacked confidence!!)  The theme of her essay 
was that she didn’t know she couldn’t do it. 
So she did it. (She says “Hire a teenager... 
while they still know everything.”)

So she wrote her 
story and put it on 
her blog, known 
as the “I can do 
anything” post. 
(Read it here... 
http://www.key-
dynamics.com/
blog/bid/301554/
Repeat-after-me-I-
can-do-anything)

People responded and were inspired, and 
through this Jackie got connected with a 
former US Chamber of  Commerce execu-
tive and FEMA professional who wants 
her to take over his nationwide speaking 
engagements.

And folks, THAT’S how it works. A 
personal connection made through social 
media that turns into a professional con-
nection. People do business with people 
they know (like, and trust), and with so 
many on social media, it’s a great forum 
to get to know new people.

So, Jackie says, build credibility... build 
an audience... be a trusted source of  in-
formation. People will keep coming back.

How do you get folks to see your post  
in the first place? It’s all about keywords 
and how you use them.

People search on keywords, in any search 
engine. The more keywords, the more it 
focuses the search. So the better you are 
at peppering your post with words and 
phrases that people might be searching 
on, the better you do at showing up in 
their search results. Paying attention to the 
keywords pays off.

Jackie likes the site http://ubersuggest.
org/ for helping her with keywords. Google  
AdWords http://www.google.com/ad-
words is another keyword helper site (not 
everything on it is free). When it comes to 
search engines, Google gives preference to 
Google+ sites.
2. Time & Commitment

To keep people interested, and coming 
back for more, you need fresh content. 
Jackie posts six times a day. She spends 
10-15 hours a week working her social 
media! That’s a big commitment of  time. 
Of  course, you can hire someone like 
Jackie to do it for you. (Graham says “Try 
Harder.” Get it?)

You need to have a personal Facebook 
page before it will allow you to set up a 
business page (or have someone with a 
personal page do it for you). On the busi-
ness page, focus on what you do well in 
your business.

Only 16% of people who “like” your page 
will ever come back. Try to be interesting 
enough to buck the odds.

http://www.key-dynamics.com/blog/bid/301554/Repeat-after-me-I-can-do-anything
http://www.key-dynamics.com/blog/bid/301554/Repeat-after-me-I-can-do-anything
http://www.key-dynamics.com/blog/bid/301554/Repeat-after-me-I-can-do-anything
http://www.key-dynamics.com/blog/bid/301554/Repeat-after-me-I-can-do-anything
http://www.key-dynamics.com/blog/bid/301554/Repeat-after-me-I-can-do-anything
http://ubersuggest.org/
http://ubersuggest.org/
http://www.google.com/adwords
http://www.google.com/adwords
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Social Media Networking
continued from page two

Graham, Joanne & Sue. Amber & Jeanne.

Jackie says a post only has a shelf  life 
of  about 3 hours. So you have to post 4-6 
times daily to keep it fresh, otherwise it gets 
buried in the crush of  everyone elses’ posts.

Every post should have new, original 
content. People should keep coming back  
to you for the breadth and depth of  your 
knowledge. 
3. It’s about THEM, not you

You shouldn’t come across as needy or 
desperate. Instead focus on your strengths 
and share information that is helpful and 
interesting to your potential clients and 
to people in general. “Do well by doing 
good.” Use the 80/20 rule - 80% about 
them; 20% about you.
4. Be Consistent

If  you can’t commit to a regular update 
schedule, don’t do it. An outdated page 
says you don’t follow through, not a good 
image builder. You want to stay out in front 
of  it, all the time. If  you don’t — it hurts 
more than helps.

Mention items on your website, products 
and services that you sell, in your posts. 
Include links back to your website, where 
these things can be purchased, but the 
80/20 rule applies here too. It cannot be 
all about making sales in your business or 
people will “unlike” you. However, you 
can (and should) provide information 
about your industry. Don’t do much hard 
“push” selling. It turns people off. Be social, 
remember?
5. Know your target group

Who is your target? What are they into? 
(Remember it’s about THEM.) Picture 
your client/target. This may also help you 
figure out which social media platform is 
right for you.

Figure out who is coming to your page. 
How can you help them? How do you 
connect with them?

Offer free promotional things to help 
bring traffic from social media sites to 
your website. A fishing guide might offer 
a downloaded document - 10 Tips for 
Catching Snook. Share your special area 
of  expertise. Once people recognize you as 
an expert, they’ll find other needs you can 
service. Make sure your website sells your 
products and services for you. You don’t 
have to be Coca-Cola to have a professional 
presence on the web.

If  you aren’t creative, aren’t a good writer, 
hire someone to do it for you. Focus on 
what YOU do best.

6. It’s about building awareness and 
credibility

It’s not about pitching sales. Be inter-
ested in your reader. Be interesting. Make 
a friend.

7. It’s about the conversation

Go back, and see what people post as 
comments. Look at who liked and shared 
it. Be on top of  it.

Be careful of  what you post. “Cyberspace 
is forever.” That applies to responding 
to comments as well. If  someone posts 
something you don’t like, take a deep 
breath and take your time to respond in a 
professional and civil manner. Try to turn 
it into an opportunity to promote your 
business and show how well you handle 
customers. Educate people. That will build 
your credibility and  mitigate the negative 
comment.

8. Social Media is part of an integrated plan

Ask customers and clients who had a 
good experience to go online and post 
about it.

What to post?

What is all this content we keep talking 
about? here are some ideas:
-  Make quality content; don’t steal from  

others
-  Post a photo and ask for comments or 

a caption. (Photos produce 39% more 
engagement on a site.)

-  Ask/answer a question
-  Talk about mistakes and lessons you’ve 

learned
-  Solicit feedback, such as asking them 

what’s their favorite dessert
-  Post something interesting from a book 

you’re reading or an article you saw
-  Share an interesting ad or commercial
-  Talk about fun purchases you’ve made, 

or ask about theirs
-  Talk about hobbies and passions
Who owns it?

You own your posts! Whatever you write 
is copyrighted, so don’t be afraid to add that 
to your site to help prevent your thoughts 
from being recycled.

Thanks, Jackie for a great evening!

Everything I know about life, I learned from 
my car, posted by Jackie Harder on Tue, Jul 
02, 2013 @ 09:16 AM. Go to http://www.
key-dynamics.com/blog/?Author=Jackie%20
Harder and scroll down.

http://www.key-dynamics.com/blog/?Author=Jackie%20Harder
http://www.key-dynamics.com/blog/?Author=Jackie%20Harder
http://www.key-dynamics.com/blog/?Author=Jackie%20Harder
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Every Apple Ad Ever Aired on TV
submitted by Karen Beal

Part Two of  Jackie’s talk was about the nuts and bolts 
of  setting up a page on Facebook, filling in as much info 
as possible to help people know more about you and what 
you are promoting or selling (remember, a Facebook page 
could be for a club or organization as well as for a person 
or a business).

She talked about what Twitter is and how it can benefit 
a business. (In the hotel business, for example, send out 
a tweet at 4pm saying “5 rooms available tonight at half  
price if  you come in by 7pm and show this tweet on your 
phone.”)

We learned what hashtags were for (topics to search or 
follow), and how tweets are addressed. 

There were a lot of  questions, and it was a good working 
session. If  you need more information, Jackie is available 
online for brief  questions, and for hire if  you need more 
than a little help.

Introducing a YouTube Channel that gives 
you every Apple ad ever aired on TV — 485 
ads, in total.

You can start with the iconic ones — the 
1984 Super Bowl commercial directed by 
Ridley Scott, which aired just weeks after 
Steve Jobs demo’ed the first MacIntosh ever. 
Or, the famous “Think Different” campaign 
from the late 1990s. The official “Think 
Different” video was narrated by Richard 
Dreyfuss, but we’d encourage you to spend 
time with the never-aired version narrated 

by Jobs himself. Other vintage ads can be 
found in these chronologically-organized 
lists: 1977-1985, 1985-1996, 1996-2007 and 
2007-2011. 

The collection also lets you sort ads the-
matically. So, you can jump into the U.S. Get 
a Mac campaign, where you’ll get plenty of  
John Hodgman. Also find versions of the 
same campaign from the UK and Japan. Fi-
nally, Apple ads featuring celebrities — from 
Bob Dylan to Zooey Deschanel to Spike Lee 
— are all neatly packaged together.

One of  Jackie’s illustrations came from this site, where these portraits are 
photographed from above. What you are looking at is people standing, sit-
ting and lying in snow! See more at http://fstoppers.com/aerial-portraits-of-
faces-using-groups-of-people

click here for link

http://fstoppers.com/aerial-portraits-of-faces-using-groups-of-people
http://fstoppers.com/aerial-portraits-of-faces-using-groups-of-people
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When you’re working in a deeply nested 
folder (a folder within a folder within…), 
the Finder provides several options for 
moving back up through the hierarchy. But 
only one option provides both at-a-glance 
info and powerful shortcuts for working 
with files: the Path Bar.

Open a Finder window (Finder > New 
Finder Window) and then choose View > 
Show Path Bar. The Path Bar appears at 
the bottom of  all your Finder windows, 
showing the complete path from your 
computer to the current folder. (A path 
is the series of  subfolders that leads to a 
specific folder or file.)

This is the only way you can see a folder’s 
path when a Finder window is in the back-
ground, but that’s merely the most obvious 
of  the conveniences the Path Bar provides.
1. Access folders in the path

Double-click a folder in the Path Bar (at 
the bottom of  a Finder window) to see its 
contents in the current window.

Is the path too long for its folder names to 
show? Just point—no clicking necessary—
to a truncated name, and it expands so that 
you can read it. This point-and-expand 
technique works even on background 
windows, whether you’re in the Finder or 
in another app. Double-click a folder in the 
Path Bar to see its contents in the current 
window. Or, open a folder into a separate 
window with a Command-double-click on 
its miniature in the Path Bar.
2. Drag a file or folder into the Path Bar 
to move it

You can save a lot of  window-juggling 
and folder-opening by dragging things 
directly into Path Bar folders. Notice a 
document or folder in the current window 
that should be elsewhere in the hierarchy? 
Simply move it into the appropriate folder in 
the Path Bar (something you can’t do with 
the Path menu available from a Command-
click on the window’s title). You can even 
drag an item from one window into another 
window’s Path Bar; just hover over the 
target folder a moment so that the window 
you’re dragging to becomes active.
3. Drag a folder out of the Path Bar to 
move it

You can manipulate the folder icons in 
the Path Bar in many of  the same ways you 
work with folders in windows.

Reveal the Path Bar in the Finder by opening 
a window and then selecting View > Show 
Path Bar. Double-click a folder in the Path Bar 
(at the bottom of  a Finder window) to see its 
contents in the current window

You can work entirely in the Path Bar when 
you want to change a folder’s position in its 
hierarchy. Just drag the folder into the desired 
parent folder.

Select an item in a Search window to see its 
path. This technique is especially convenient 
when you have identically named files or 
folders.

Five overlooked abilities of the Finder’s Path Bar
by MacWorld’s Sharon Zardetto @SharonZardetto; submitted by Graham Thomas

Drag a Path Bar folder into any other 
folder or window, or onto the Desktop. You 
can even hold down Option as you drag to 
make a copy of  the folder, or Command-
Option to make an alias. Want to access 
one of  those Path Bar folders frequently? 
Drag it into the sidebar. As with standard 
folder icons, if  you drop a Path Bar folder 
in the wrong place, use Edit > Undo Move 
(Command-Z) to put it back. Or, if  you 
change your mind while you’re dragging 
the folder (when making an alias or copy, 
for example), press Esc to cancel the opera-
tion, and the “drag ghost” disappears from 
the arrow pointer.
4. Drag a folder within the Path 
Bar to move it

Working with files in the Path 
Bar can be a big timesaver. Say, 
for instance, you notice that some-
thing is in the wrong place in the 
path (you put FebNews inside 
JanNews instead of  inside the 
parent folder Newsletters). You 
can fix everything within the Path Bar just 
by moving the FebNews folder icon into 
the Newsletters folder icon.

You can work entirely in the 
Path Bar when you want to 
change a folder’s position in its 
hierarchy. Just drag the folder 
into the desired parent folder.
5. Navigate search windows 
with the Path Bar

The Path Bar is an everyday, 
every-window convenience, but is 
especially useful in Finder search 
windows. While a standard win-
dow displays the contents of a single folder 
and the Path Bar shows its path, a search 
window lists items from all over the place, and 
its Path Bar shows you where any selected 
item lives. (If  you make multiple selections, 
the Path Bar cleverly shows the nearest folder 
that they all have in common.)

So, if  you get a dozen hits for, say, 
FebNews, you can select each one in turn 
to see its path. When you find the one 
you want, you can check what else is in 
its folder by double-clicking that folder 
in the Path Bar or—even better in most 
circumstances—using a Command-click 
to open it in a separate window, keeping 
your found list at hand so that you can 
check the other items.

Have you Cut the Cord?
Here are 75 full episodes from PBS 
Nature series. Another example of 

stations offering their shows online.

http://video.pbs.org/video/2338524490

http://video.pbs.org/video/2338524490
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<The spellchecker 
officially HATES 
this article!!—Sue

GEEK MEDITATION SESSION
Another of  Jackie’s  fun illustrations.

Create your first 
interactive book 
using iBooks 
Author

sent by Karen Beal

This book is available 
for download on your 

iPad with iBooks or on your computer 
with iTunes.

Have you always wanted to become an 
author? Now there’s an app for that. iBooks 
Author allows you to publish your own 
content to the iBookstore, making it avail-
able to over 60 million iPads worldwide.

In this guide, you’ll learn how to:
- Create your own interactive books with 

iBooks Author.
- Add images, movies, and sounds to 

turn your book into a multimedia 
masterpiece.

- Use interactive widgets to engage your 
readers like never before.

- Publish your books either as a free or 
paid download

We’ve pulled everything from the finest 
sources to provide you with answers to your 
most pressing concerns about publishing 
with iBooks.

I remember seeing ‘the future’ in com-
puters 10 years ago with hand/motion 
activated touch screens and wall screens 
- thinking Wow! So maybe in 5 years 
(thinking compressed timing of  progress 
these days) my computer will be doing this.  

http://www.ted.com/talks/jinha_
lee_a_tool_that_lets_you_touch_pixels.
html?utm_source=newsletter_weekly_2013-
07-06&utm_campaign=newsletter_
weekly&utm_medium=email&utm_
content=talk_of_the_week_image

Reach in and touch a pixel

by Karen Beal

Strong password ideas
submitted by Karen Beal

Wow! I’ve seen this with  the letters out of  order, but this is the first 
time I’ve seen it with  numbers. This is what Jack was taking about for 
making strong passwords, and it’s a good example of  a brain exercise: 
If  you can  read this you  have a strong mind. And better than that: 
Alzheimer’s is a long, long, way down the road before it ever gets 
anywhere near you.  

7H15  53RV35 7O PR0V3  
H0W 0UR M1ND5  
C4N D0 4M4Z1NG  
7H1NG5!  
1MPR3551V3  7H1NG5!  
1N 7H3  B3G1NN1NG  
17 WA5 H4RD  
BU7 N0W, 0N 7H15  LIN3 
Y0UR M1ND  
1S R34D1NG  
17 4U70M471C4LLY  
W17H 0U7  
3V3N 
7H1NK1NG 4B0U7 17, 

B3 PROUD!  
0NLY C3R741N P30PL3  
C4N R3AD 7H15.  

 Can you raed this? Olny  55 
plepoe out of  100 can. I cdnuolt 
blveiee that I cluod aulaclty ues-
dnatnrd  what I was rdanieg. The 
phaonmneal pweor of  the hmuan 
mnid, aoccdrnig to  a rscheearch 
at Cmabrigde Uinervtisy, it dseno’t 
mtaetr in what oerdr the  ltteres 
in a word are, the olny iproamtnt 
tihng is that the frsit and last  ltteer 
be in the rghit pclae. The rset can 
be a taotl mses and you can  still 
raed it whotuit a pboerlm. This is 
bcuseae the huamn mnid deos not 
raed  ervey lteter by istlef, but the 
word as a wlohe.

 Azanmig huh? Yaeh and I  awlyas 
tghuhot slpeling was ipmorantt!       

How to block an unwanted 
caller’s number on an 
iPhone

from http://www.ugnn.com/2013/07/
how-to-block-an-unwanted-callers-number-

on-an-iphone/

I actually had this issue a couple of  weeks 
ago when my granddaughter started get-
ting harassing phone calls from a former 
friend.  So I was happy to find this article 
on the Macworld UK Web site.

I wound up calling AT&T and have them 
block the number from her phone.  That is 
a service they have that is normally $5 a 
month, but I lucked out and they are pro-
viding 3 months at no charge.  I’m hoping 
by then the person doing the harassment 
will have given up or gotten bored with 
the whole process.

The Macworld article provides the fol-
lowing points:
•	 Set	up	an	‘unwanted	caller’	con-

tact.  ”Ignore this idiot”
•	 Make	a	“silent”	ringtone	to	silence	

the call from the harasser.
•	 Jailbreak	your	iPhone,	and	block	

numbers using Call Blocker, Call Bliss 
or another unofficial app (Not recom-
mended!!—Sue)

The good news is that once iOS 7 is re-
leased, reportedly it will have call blocking 
built into the OS.

See the full article with details here:
http://www.macworld.co.uk/ipad-

iphone/news/?newsid=3457215

http://www.ted.com/talks/jinha_lee_a_tool_that_lets_you_touch_pixels.html?utm_source=newsletter_weekly_2013-07-06&utm_campaign=newsletter_weekly&utm_medium=email&utm_content=talk_of_the_week_image
http://www.ted.com/talks/jinha_lee_a_tool_that_lets_you_touch_pixels.html?utm_source=newsletter_weekly_2013-07-06&utm_campaign=newsletter_weekly&utm_medium=email&utm_content=talk_of_the_week_image
http://www.ted.com/talks/jinha_lee_a_tool_that_lets_you_touch_pixels.html?utm_source=newsletter_weekly_2013-07-06&utm_campaign=newsletter_weekly&utm_medium=email&utm_content=talk_of_the_week_image
http://www.ted.com/talks/jinha_lee_a_tool_that_lets_you_touch_pixels.html?utm_source=newsletter_weekly_2013-07-06&utm_campaign=newsletter_weekly&utm_medium=email&utm_content=talk_of_the_week_image
http://www.ted.com/talks/jinha_lee_a_tool_that_lets_you_touch_pixels.html?utm_source=newsletter_weekly_2013-07-06&utm_campaign=newsletter_weekly&utm_medium=email&utm_content=talk_of_the_week_image
http://www.ted.com/talks/jinha_lee_a_tool_that_lets_you_touch_pixels.html?utm_source=newsletter_weekly_2013-07-06&utm_campaign=newsletter_weekly&utm_medium=email&utm_content=talk_of_the_week_image
http://www.ugnn.com/2013/07/how-to-block-an-unwanted-callers-number-on-an-iphone/
http://www.ugnn.com/2013/07/how-to-block-an-unwanted-callers-number-on-an-iphone/
http://www.ugnn.com/2013/07/how-to-block-an-unwanted-callers-number-on-an-iphone/
http://www.macworld.co.uk/ipad-iphone/news/?newsid=3457215
http://www.macworld.co.uk/ipad-iphone/news/?newsid=3457215


Macaholics UNANIMOUS Page 7

8 Ways to Make 
Facebook Less 
Annoying

from http://www.ugnn.com/2013/07/8-
ways-to-make-facebook-less-annoying/

  This article by Andrew Hayward on the 
Mac|Life web site gives us 8 ways to make 
Facebook more enjoyable.  

These items are:
Only Important Updates – this tells you 

how to change what updates you are getting 
from each individual

… Or Zero Updates – Remain friends 
but avoid that person’s updates for now 
or forever.

Turn Off Email Notifications – Self  
explanatory, but my favorite anyway.

Choose Wisely – Select who you want 
your updates to go to.  (Especially if  you are 
playing a Facebook game and don’t want 
to aggravate your friends with “requests”.)

Disable Game Requests – What you 
do with those game requests that are ag-
gravating you.

Keep Your Wall Yours – You decide 
which tagged posts appear on our Timeline.

Kill False Endorsements – Don’t let 
Facebook tell people what you like.

Disable Imported Tweets – If  you are 
already following people on Twitter, you 
don’t need their Tweets appearing again 
on Facebook.

I found most of  these under the little gear icon 
when I was logged on to Facebook. —Sue

How did they do 
that?

by Sue Beal

I came into the office one morning 
and my iCal was on the screen with 
an event on it that came from a spam 
email I had not even seen yet. (Screen 
shot of  calendar to the right.)

How did they do that??? I felt vio-
lated. Only I put things on my calendar. 
How could a spammer get access?

So I emailed Jack Buccellato of  All 
Keys ComputerGuys,and posed the 
question.  He asked me if  my prefer-
ences allowed anyone to put invitations 
on my calendar.

I opened the Prefer-
ences under Mail, and 
sure enough, it was set 
to allow invitations to 
be added to iCal auto-
matically! Now it is set 
to NEVER.

I don’t know about 
you, but I hate the idea 
that someone could be 
messing with my calen-
dar behind my back!! It 
must default to “auto-
matic” because I know I 
didn’t set it up that way. 
So check yours.

Thanks, Jack for a 
quick and reassuring 
response!

Afraid to open that attachment?
Tip by Karen Beal, written by Sue Beal

Jack B taught us not to open attach-
ments from emails we aren’t certain are 
from friends and family or other safe 
sources.

But sometimes you get one and you just 
don’t know. For example, my husband is 
in Pennsylvania doing some repairs, and 
he’s buying things at all kinds of  home 
improvement stores.

I spotted an email in my spam from 
Home Depot. I looked at it closely and 
it had his name on it, the logo and colors 
looked legit, the English was correct, it 
all looked good. (These are all things 
Jack said to look for.) But it had a PDF 
sales slip attached, and that made me 

nervous. I just wasn’t sure I wanted to 
double click on it and risk getting a Trojan 
or virus. Why would they be emailing 
me a sales slip, when he was right there 
to hand it to?

Karen came over, and I asked her 
about it. She said to click it once (NOT 
a double click) and then hit the space bar. 
A Quick Look window popped up and 
showed me that it was a legitimate sales 
receipt from something JC had bought 
at the Beaver Falls store. Karen said that 
by using the space bar for a Quick Look, 
it’s not really opening it, it’s just using 
the preview, so it’s safe.

I feel better! Another good one from Jackie Harder.

http://www.ugnn.com/2013/07/8-ways-to-make-facebook-less-annoying/ 
http://www.ugnn.com/2013/07/8-ways-to-make-facebook-less-annoying/ 
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Apple computer sells for $387,750

By Associated Press,July 10, 2013
sent in by Lindi Mallison

    An Apple 1 computer sold on Monday, 
July 8, 2013 for $387,750 at a Christies 
online-only auction. Bolaffi, an Italian 
collections company, says in a statement 
that it bought the computer. The seller 
was a retired school psychologist from 
Sacramento, Calif.

Vintage Apple products have become 
a hot item since Steve Jobs’ death in Oc-
tober 2011. Jobs joined forces with Steve 
Wozniak to build computer prototypes in 
a California garage, and Wozniak built 
the Apple 1.

Watch out for the “unsubscribe”!
by Sue Beal

People like to tell spammers to stop by unsubscribing. But even that can be a trap.
Look at this spam I received, below. It looks like all they expect you to do here is 

unsubscribe!! (Of  course, the main graphic was missing. That’s a huge tip it’s not legit.)
But look at the “from” email, and somehow the “to” says miller@bellsouth.net” - 

that’s not me!! The mailing address to unsubscribe is another red flag, and look at that 
address! If  you google the mailing address, it’s linked to spammers.

Since Jack taught us what to look for, I love playing detective.

Fact Checking
If  you are getting tired of  all the ridicu-

lous stories that are spread across the social 
networks, then you will appreciate this list 
of  Fact Checking web site.  

This article by technorms.com lists six 
sites that you can use to find out that Bill 
Gates really isn’t giving cash to everybody 
who like a particular picture or the story 
that makes a particular politician look 
stupid even though you know that any 
politician at that level would never make 
such a dumb statement where it could be 
heard.

The sites they list are:

FactCheck.org – a nonpartisan, non-
profit “consumer advocate for voters

PolitiFactcom – from the St. Petersburg 
Times checks statements by members of  
Congress, the White House and interest 
groups.

OpenSecrets.org – Nonpartisan guide 
to money’s influence on US elections and 
public policy.

Snopes.com – Debunks urban legends 
and rumors on a huge number of  topics

TruthOrFiction.com – Get the truth 
about rumors, inspirational stories, virus 
warnings, hoaxes, etc. that you might get 
in your email.

HoaxSlayer.com – Also debunks email 
and tries to educate web users about se-
curity issues.

To get the complete article complete with 
links, go here: http://www.technorms.
com/454/get-your-facts-right-6-fact-
checking-websites-that-help-you-know-
the-truth

OUR LINKS ARE LIVE!
If you haven’t figured it out yet, try it. 
Click on any blue, underlined link in 

our Macaholics Unanimous newsletter 
and it will take you to the web.

“The secret to happiness is: 
Always get as much RAM as                 

you can possibly afford.”

Digital Bread Crumbs: 
Following Your Cell Phone Trail

from NPR.org
submitted by Diane Marshall

http://www.npr.org/templates/story/
story.php?storyId=114241860&sc=emaf

FactCheck.org
PolitiFactcom
OpenSecrets.org
Snopes.com
TruthOrFiction.com
HoaxSlayer.com
http://www.technorms.com/454/get-your-facts-right-6-fact-checking-websites-that-help-you-know-the-truth
http://www.technorms.com/454/get-your-facts-right-6-fact-checking-websites-that-help-you-know-the-truth
http://www.technorms.com/454/get-your-facts-right-6-fact-checking-websites-that-help-you-know-the-truth
http://www.technorms.com/454/get-your-facts-right-6-fact-checking-websites-that-help-you-know-the-truth
http://www.npr.org/templates/story/story.php?storyId=114241860&sc=emaf
http://www.npr.org/templates/story/story.php?storyId=114241860&sc=emaf
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Ransomware Masked as FBI Notice Targets OS X Users
from http://www.maclife.com/article/gallery/ransomware_masked_fbi_notice_targets_os_x_users

submitted by Pam Marmar

Remember when Apple’s Mac OS was 
largely a niche system and the cyber thugs 
of  the world largely left us alone? There 
were some good aspects about those days, 
as Malwarebytes reminds us with a report 
of  some nasty “ransomware” currently 
circulating through Macs that masquer-
ades as an official FBI notice demanding 
$300. Trojans like these are old news for 
most Windows users, but they’re unfamil-
iar enough on Macs that they might catch 
some users unaware. Worse yet, they 
also feed on contemporary fears about 
the monitoring of  electronic devices by 
the NSA. It certainly looks official, and 
it’s largely (but not entirely) free of  the 
little grammatical slips and typos that 
usually make these scams so identifiable. 
Fortunately, it’s not even that danger-
ous, partially thanks to Apple’s closed 
system. All it does is open up around 150 
separate iframe windows with ominous 
messages like “You have been viewing 
or distributing Pornographic content” 
and--surely the coders in charge must 
be laughing at this one--“your computer 
may be infected by malware, thus you are 
violating the law on Neglectful Use of  
Personal Computer.” There is no such 
law. Big Brother may be watching you, 
but we’re still free to foul up our own 

computers as we 
please.

To clear the mes-
sage, you’re ex-
pected to pay $300 
to the site, payable 
through GreenDot 
MoneyPak cards 
you can pick up at 
most gas stations. 
(Don’t.) It’s even 
designed to acti-
vate after certain 
popular searches: 
in one confirmed 
case, for instance, it popped up after a 
user searched for Taylor Swift on Micro-
soft’s Bing image search. This isn’t just a 
swipe at Apple enthusiasts using Bing--as 
VentureBeat reports, ever since Google 
severely tightened the adult content 
revealed through its image search back 
in December, porn surfers have been 
flocking to Microsoft’s search engine. 
According to Malwarebytes, the scam 
doesn’t work on mobile devices.

In practice, all you really need to do 
in order to get rid of  the windows is to 
close them individually, but the design 
of  the service obviously hopes that users 
will tire of  the process and give in and 

pay the money. According to the report, 
Safari’s practice of  reopening windows 
means that simply closing the app and 
restarting does little to nothing to resolve 
the issue for tech lightweights. 

As MacRumors points out, you can 
get around this by holding down the 
Shift key as you restart Safari or simply 
by disabling the feature within Mac OS 
X’s General tab in System Preferences. 

Considering that Malwarebytes appar-
ently wasn’t even aware of  this simple step, 
that doesn’t bode well for the many desk-
top and notebook owners who haven’t 
taken the time to  learn the ins and outs 
of  their systems.

Saving More Online
by Karen & Sue Beal

Karen taught me to always stop before I 
check out online and search for an e-coupon 
or deal that might be applied before I settle 
on the bottom line of  an order.

Lately I have been discovering that 
generic OTC drugs and supplements pur-
chased through Amazon can be a HUGE 
savings over buying at the local drugstore 
or even over supermarket generics. (The 
Kirkland brand factors heavily in this, and 
it’s Costco’s house brand. So if  you belong 
to Costco and actually shop there, you 
probably already know about the savings.)

Here are couple more places to find sav-
ings that Karen just sent me, She wrote, 
“Here are more sources for deals, discounts 
and free shipping codes I saw in AARP 
Magazine:”  

http://www.couponcabin.com
http://www.bradsdeals.com
http://www.retailmenot.com

And for those of  you who have been 
watching Extreme Couponing and are 
inspired to start shopping with more cou-
pons, try http://www.Klip2Save.com. It’s a 
clipping service. For pennies on the coupon 
(and no minimum) you can purchase mul-
tiples and stock up on your favorite deals.

I’ve tried quite a few couponing sites. This 
one is the best. Easy to search, organized, 
pleasing to the eye and no flashing ads in 
your face. They don’t flake out and disap-
pear for weeks at a time like some sites. The 
coupons arrive in 3 days. They don’t ask 
for any personal information or fill your 
inbox with unwanted spam. They charge 
$1 “overhead” for shipping and handling 
per order. Pretty reasonable. 

skeuomorph
submitted by Karen Beal

PRONUNCIATION:
(SKYOO-uh-morf) 

MEANING:
noun: A design feature copied from a 

similar artifact in another material, even 
when not functionally necessary. For ex-
ample, the click sound of  a shutter in an 
analog camera that is now reproduced in 
a digital camera by playing a sound clip. 

A skeuomorph can be employed for vari-
ous purposes. Since people are used to the 
click sound of  a camera as feedback that the 
picture has been taken, it is now artificially-
produced in digital cameras. Other examples 
are copper cladding on a zinc penny (for 
familiarity) and wood finish on a plastic 
product (for a more expensive look).

http://www.maclife.com/article/gallery/ransomware_masked_fbi_notice_targets_os_x_users 
http://www.couponcabin.com
http://www.bradsdeals.com
http://www.retailmenot.com
http://www.Klip2Save.com


Macaholics UNANIMOUS Page 10

FREE CLASSES
The Apple Store at the Falls has free classes 

every  Saturday!  They also have one-on-one 

training, workshops and the Genius Bar. Call 

or check the web for more info:

Apple Store at The Falls
305-234-4565 
8888 SW 136th Street
Miami, FL 33176  
Mon-Sat:10-9:30pm
Sun: noon-7pm

http://www.apple.com/retail/thefalls

Come at
6:30 for the

Beginners Circle:
Bring your laptop 

and your questions 
at 6:30, and for a half-hour
prior to the main meeting 

we'll have experienced 
folks available to help, 

one on one, or in 
small groups.

FREE CLASSES IN KEY WEST!
Macintosh™ Systems Solutions has a free class 

almost every Saturday morning at the store in Key 
West! Visit them at 1001 Truman Avenue at the cor-
ner of  Grinnell. They offer a wide range of  classes 
for new and experienced Mac users. Stop by for all 
your Apple sales, service, and training needs, or call 
293-1888.

Did you see that picture         
of you, taken at the last 

meeting? 

http://ukmug.pbworks.com/

Color Copies •  Large or Small Orders
Rack Cards • Business Forms & Checks • Brochures

Business Cards • Letterhead • Envelopes

Signs and Banners • Multi-Part Forms • RX pads 

Posters • Rubber Stamps • Graphic Design

305-664-1002 
81933 Overseas Hwy., Islamorada

printsourcekeys@yahoo.com

M U  C l a s s i f i e d s

Got Stuff  for Sale or Give-

away? Need Something?

Email ukmug@bellsouth.

net and I’ll post it here.

The Official Newsletter of the Upper Keys Macintosh Users Group August 1993                   Volume 1, Issue 1

is the official newsletter of the

Upper Keys Mac Users Group
A nonprofit organization devoted to the use (and 
sometimes abuse) of the Macintosh computer. 
Subscriptions are $25.00 for one year. Contents © 
1993 - 2013 by the Upper Keys Macintosh Users 
Group except where noted. All other rights reserved. 

219 Second St. • Key Largo FL 33037
(305) 451-4601 • ukmug@bellsouth.net

Share! Send us your stuff!

VISIT TODAY!
http://ukmug.pbworks.com/

Post questions and requests for help
Post tips and tricks

Post your favorite links
Check on upcoming meetings

Download our newsletters & more!

VISIT TODAY!
http://ukmug.pbworks.com/

Monroe County Recycling
 Collection Center: MM 100.1 

Oceanside (Magnolia St.) 
453-0788

E-RECYCLING: 2nd & 4th Wed. 
every month, 10am - 2pm 

E-waste: Monitors & Computers
 Batteries, Televisions, All Telephones
& FAX Machines, Printers / Copiers, 

DVD / VCR Players, Radios & 
Speakers, Discs & Cassettes 

Also taking Hazardous Household Waste.

dummies.com 
is a great place for
 useful and brief          

Mac Tips and Tricks! 
Check it out!

http://www.apple.com/retail/thefalls
http://ukmug.pbworks.com
mailto:ukmug@bellsouth.net
mailto:ukmug@bellsouth.net
mailto:ukmug@bellsouth.net
http://ukmug.pbworks.com
http://ukmug.pbworks.com
dummies.com

